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Preface
During software development, the product quality needs to be improved in the earlier phase of project development, thus reducing
subsequent project revision and project development costs. The Agile+ Relief J is a product that is used to improve the product quality in
the phase of project compiling during project development. Through the static analysis of the programs written by Java language, the
problems that are ignored visually can be detected. Thus, the product quality can be improved, and the development costs can be reduced.

 
What Is Agile+ Relief J?

Agile+ Relief J provides the functions of Agile+ Relief J customization (hereinafter referred to as customization) and Agile+ Relief J Code
check (hereinafter referred to as Code check).

- Customization

Formulating the coding rules as the development standard of project development.

- Code check

Statically parsing the source code described by Java language to detect coding rule violation through customizer.

 
Users and Roles of Agile+ Relief J

The following figure shows the users and roles of Agile+ Relief J.

- Program specification designer

The program specification designer determines the coding rules as the development standard of project development, understands the
checking rules of Agile+ Relief J, creates coding rules through customization, and publishes the formulated coding rules to the developer
and quality manager.

- Developer

The developer performs coding according to the coding rules. In addition, the developer checks whether there are rule violations exist
through Code check, saves the result as a file, and sends the file to quality manager.
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- Quality manager

The quality manager performs final judgment on whether the codes comply with the coding rules, judges whether quality is abnormal
or not according to the Code check result sent from the developer and confirms the validity of coding rules.

The users do not need to be of different roles. "The developer formulate coding rules and confirm whether the described codes comply with
the coding rules".

Especially when the developer wants to append coding rules, the developer must fully negotiate with users.

 
About This Manual

This manual describes the overview and operation methods of Code check.

For details of customizer, refer to "Agile+ Relief J Customizer Operation Guide".

The operation specification of this manual has been described based on Eclipse 3.4. Please read according to the term of the development
environment used when you use Eclipse of other versions or Interstage Studio.

 
Trademarks

- Microsoft, Windows, Windows Server are the registered trademarks or trademarks of Microsoft Corporation in the United States, and
other countries

- Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their respective owners.

- Interstage is the registered trademark of Fujitsu.

- Interstage Studio is a product of Fujitsu.

- The name FindBugs™ and the FindBugs logo are trademarked by The University of Maryland

- Android is the registered trademarks or trademarks of Google Inc.

- The names of other products and services referred to in this document are trademarks of their respective developers and manufacturers.

All rights reserved, Copyright(C) 2009-2023 FUJITSU LIMITED.
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Chapter 1 Overview
This chapter describes the overview of Code check and the applicable asset.

1.1 What is Code check?
Code check indicates the input of coding rules created by the program specification designer through customization and the check of coding
rule violations by static analysis of the source program written by Java language. Code check is operated on Eclipse of Java development
environment and is provided as the Eclipse plug-ins. The developer can perform Code check at any time during program development on
Eclipse to check coding rule violations.

The Code check is performed in terms of the following aspects.

- Reliability

Rules for checking the bugs that may cause complex control structure and incorrect use of API.

- Maintainability/Readability

Rules for checking the violation of the naming rules of class and method and coding rules .etc.

- Efficiency

Rules for checking the string and file operations, DB access and XML .etc that may cause performance deterioration.

- Functionality

Rules for checking the security vulnerability such as SQL injection and cross site scripting (XSS).

- Portability

Rules for checking the part with problems during the migration to other platforms such as OS-dependent code.

1.2 Applicable Asset
The assets that are set as the objects to be checked are as follows:

1.2.1 Eclipse project of target for Code check
The following Eclipse projects become objects to be checked.

 
Java Project

It is Eclipse project made for the development of the Java application.

 
Android Application Project

It is Eclipse project made for the development of the Android application.

1.2.2 File of target for Code check
The following files in the Eclipse project shown by "1.2.1 Eclipse projects of target for Code check" become objects of code check.

 
Java file

- The extension is ".java".

- The Java program in conformity with Java Language Specifications of JDK 1.4/5.0/6/7/8 applies.

- The character code is Cp1252 or UTF-8.

- All of the java files to be checked use the same character code.
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XML file

- The extension is ".xml".

- The following XML files become objects, and it is checked by Agile+ Relief J for the Android project.

- AndroidManifest.xml

- XML file under the control of resource folder (res/xml、res/menu、res/layout、res/layout-xxx)

- The cooperation with PMD is effective and the version of PMD is since 5.0. In this case, all XML files under the control of the folder
to be checked become objects, and they are checked by PMD.

 
JSP file

- The following extensions are targeted.

- Before PMD 4.3 : ".jsp", ".jspx"

- Since PMD 5.0 : ".jsp"

- It becomes an object when cooperation with PMD is effective, and it is checked by PMD.

 
StyleSheet file

- The extension is ".xsl" and ".xslt".

- The cooperation with PMD is effective and the version of PMD is since 5.0, and they are checked by PMD.

 
ECMAScript file

- The extension is ".js".

- The cooperation with PMD is effective and the version of PMD is since 5.0, and they are checked by PMD.

 
PLSQL file

- The extension is ".sql" , ".trg", ".prc", ".fnc", ".pld", ".pls", ".plh", ".plb", ".pck", ".pks", ".pkh", ".pkb", ".typ", ".tyb", ".tps", and ".tpb".

- The cooperation with PMD is effective and the version of PMD is since 5.1, and they are checked by PMD.

 
Apache Velocity file

- The extension is ".vm".

- The cooperation with PMD is effective and the version of PMD is since 5.1, and they are checked by PMD.
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Chapter 2 Preparations for Code check
This chapter describes the installation procedure for using Agile+ Relief J on Eclipse.

2.1 Install Agile+ Relief J Plug-in
To install Agile+ Relief J, JDK and Eclipse must be required as the operating environment. Please prepare the operating environment in
advance.

After installing the plug-in of Agile+ Relief J on Eclipse, the functions of the Agile+ Relief J can be used.

2.1.1 Set the Environment Variable JAVA_HOME
Set JAVA_HOME in the environment variable of Windows. Set the installation directory of JDK in JAVA_HOME.

If JDK is not installed, please obtain JDK 5.0 or earlier versions from the website of Oracle and install it.

The website of Oracle is: http://www.oracle.com/technetwork/java/index.html

<Operations>

1. Right-click [Computer]* and select [Properties].

2. Click the "Advanced system settings" menu on the left side of the [System] window. The "System Properties" dialog box is displayed.

3. Select the [Advanced] tab in the "System Properties" dialog box and click the [Environment Variables] button.

The [Environment Variables] dialog box is displayed.

4. Specify the path of JDK installed in the environment variable JAVA_HOME.

* Right-click [PC] since Windows8.1 or Windows Server 2012 R2.

2.1.2 Prepare Eclipse
You can obtain the Eclipse file from the download page of Eclipse Project and install Eclipse.

The Eclipse Project download page is: http://www.eclipse.org/downloads/

<Operations>

1. Decompress the downloaded Eclipse archive.
For example, when decompressing to "c:\", unfold eclipse.exe and the files and folders required for running Eclipse to "c:\eclipse".

* Please install Interstage Studio that has it when you use Interstage Studio. Please refer to the manual of Interstage Studio for details of the
installation.

2.1.3 Install Plug-in of Agile+ Relief J
Install the plug-in of Agile+ Relief J in Eclipse.

Plug-in of Agile+ Relief J

The following plug-in of the Agile+ Relief J are stored in the "Installation folder of AgilePlus \PGReliefJava\eclipse\plugins" folder.

com.fujitsu.jp.fst.pgrelief.java.eclipse.doc.detail_x.x.x.jar

com.fujitsu.jp.fst.pgrelief.java.eclipse.doc.guide_x.x.x.jar

com.fujitsu.jp.fst.pgrelief.java.eclipse_x.x.x.jar

*x.x.x refers to the version of plug-in.

<Operations>
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1. Copy the plug-in folder of the Agile+ Relief J installation directory to the plugins folder or the dropins folder of the Eclipse installation
directory.

Example)

When the path for unfolding the Eclipse file is "C:\eclipse", and the path for installing Agile+ Relief J is "C:\Program Files\AgilePlus
\PGReliefJava".

copy "C:\Program Files\AgilePlus\PGReliefJava\eclipse\plugins" "C:\eclipse\plugins"

2. Start eclipse.exe.

eclipse.exe

If [Agile+ Relief J] is displayed on the menu of Eclipse, it indicates that the plug-in is installed successfully.

 

 Information

If [Agile+ Relief J] is not displayed on the menu of Eclipse, please confirm the perspective customization of Eclipse.

Confirm whether the commands and groups of [Agile+ Relief J] in the [Customize Perspective] dialog of Eclipse are valid. If it is invalid,
validate them.

<Operations>

1. Select [Window] > [Customize Perspective...] from the menu of Eclipse.

The [Customize Perspective] dialog is displayed.

2. Check whether [Agile+ Relief J] is selected from the list of [Commands] > [Available Command groups].

3. When [Agile+ Relief J] is not selected, select it and click the [OK] button.

[Agile+ Relief J] is displayed on the menu of the main window.
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2.1.4 Set View Display in the Eclipse
To display the view in use through the plug-in of Agile+ Relief J, please perform the following operations.

<Operations>

1. Select [Window] > [Show View] > [Other...].

The [Show View] dialog is displayed.

2. Select the following displayed views of Agile+ Relief J and click the [OK] button.

- [Agile+ Relief Confirmation Status]

- [Agile+ Relief Message Detail]

- [Agile+ Relief Message list]

2.2 Set Environment for Code check
Set the environment for using Agile+ Relief J on Eclipse.

The following items need to be set.

- Set Check Rule Definition File

- Set output folder for Code check result

- Set Options for Building

- Set Maximum Heap Size for Code check
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2.2.1 Change to the Status that Agile+ Relief J can be used
Before setting the environment of Agile+ Relief J, it is required change to the status of that Agile+ Relief J can be used in advance.

<Operations>

1. Select [Agile+ Relief J] > [Use Agile+ Relief J] from the menu of Eclipse.

If [Agile+ Relief J] > [Use Agile+ Relief J] is selected from the menu of Eclipse, it indicates that the Agile+ Relief J can be used.

2.2.2 Set Check Rule Definition File
Specify the check rule definition file of the project development rules used for Code check. (The extension of the check rule definition file
is "pgrj").

The content that has been set here will be default of all the projects in the currently-developed workspace.

For details about the project-specific settings of the project unit, please refer to "2.2.6 Project-Specific Settings".

<Operations>

1. Select [Window]>[Preferences].

The [Preferences] dialog is displayed.

2. Select [Agile+ Relief J] from the tree.

The setting screen of Agile+ Relief J is displayed.

3. Specify the check rule definition file in [Setting of check rule definition file], perform either of the following operations.

- Click [Browse...] and select a file from the file selection dialog box

- Enter a file name in full path
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Example: When the check rule definition file is "C:\Program Files\AgilePlus\PGReliefJava\rule.pgrj"

 

 See

Click [Customizer is starting...] to start the customization and edit the preset check rule definition file.

For details on how to edit the check rule definition file, please refer to "Agile+ Relief J Customizer Operation Guide"

2.2.3 Set output folder for Code check result
Specify output folder for Code check result. Eclipse project folder or any other folder can be specified as the output folder. Output format
to each output destination is as follows:

- If Eclipse project folder is specified:

Output is made under the project folder of section to be checked.

- If other folder is specified:

A folder, which has the same name as the project to be checked, is created under the specified folder and output is made under the folder.

The content that has been set here will be default of all the projects in the currently-developed workspace.

For details about the project-specific settings of the project unit, please refer to "2.2.6 Project-Specific Settings".
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<Operations>

1. Select [Window]>[Preferences].

The [Preferences] dialog is displayed.

2. Select [Agile+ Relief J] from the tree.

The setting screen of Agile+ Relief J is displayed.

3. Specify output folder in [Setting output folder for Code check result], perform either of the following operations.

- If output is to be made under the Eclipse project folder

Select [Eclipse project folder].

- If output is to be made under any folder other than the Eclipse project folder

1. Select [Specify a folder].

2. Specify output folder, perform either of the following operations.

- Click [Browse...] and select a folder from the folder selection dialog box

- Enter a folder name in full path

Example: When output folder for Code check result is "C:\AgilePlus\result"

 

 Note

If the setting of the output folder for Code check result is changed, and Code check result exists in the folder before/after the change, delete
the check result. Note that because of this, performing the Code check again would be necessary. In addition, regarding the closed project,
it is not deleted even if the Code check result still exists, therefore the Code check result may not be displayed properly when the project
is opened. In this case, perform the Code check once again.
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2.2.4 Set Options for Building
Set the operations of Code check during building.

After [Perform code check when building] is selected, the Code check is automatically performed after building completed.

The content that has been set here will be default of all the projects in the currently-developed workspace.

For details about the project-specific settings of the project unit, please refer to "2.2.6 Project-Specific Settings".

<Operations>

1. Select [Window] > [Preferences].

The [Preferences] dialog is displayed.

2. Select [Agile+ Relief J] from the tree.

The setting screen of Agile+ Relief J is displayed.

3. When Code check is performed during building, check the [Perform code check when building] checkbox.

2.2.5 Set Maximum Heap Size for Code check
Set maximum heap size of Java Runtime for Code check.

Please set an bigger value as the maximum heap size when the out of memory occurs by Code check to a large-scale project etc.
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The content that has been set here will be default of all the projects in the currently-developed workspace.

For details about the project-specific settings of the project unit, please refer to "2.2.6 Project-Specific Settings".

<Operations>

1. Select [Window] > [Preferences].

The [Preferences] dialog is displayed.

2. Select [Agile+ Relief J] from the tree.

The setting screen of Agile+ Relief J is displayed.

3. Specify the numerical value in the [Maximum heap size (MB)] textbox.

 

 See

Refer to "About Memory Insufficiency" of "6.1 Code check" for the problem of out of memory concerning Eclipse like the code check result
display etc.

2.2.6 Project-Specific Settings
The check rule definition file and the output folder for Code check result and the options for building and the maximum heap size for Code
check can be set as the project-specific settings of a project.

To configure the project-specific settings of a project, perform the following operations.

<Operations>
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1. Select [Project] > [Properties].

The [Properties] dialog of the applicable project is displayed.

2. Select [Agile+ Relief J] from the tree.

The page of setting the Agile+ Relief J is displayed.

3. When specifying the check rule definition file, select [Enable the project-specific setting that is relating to the setting rule definition
file].

[Setting of check rule definition file] is enabled.

4. Specify the check rule definition file, perform either of the following operations.

- Click [Browse...] and select a file from the file selection dialog box

- Enter a full path to the text box.

5. When specifying output folder for Code check result, select [Enable project-specific setting related to the setting of the output folder
for Code check result].

[Setting output folder for Code check result] is enabled.

6. Specify output folder for Code check result in [Setting output folder for Code check result], perform either of the following
operations.

- If output is to be made under the Eclipse project folder

Select [Eclipse project folder].
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- If output is to be made under any folder other than the Eclipse project folder

1. Select [Specify a folder].

2. Specify output folder, perform either of the following operations.

- Click [Brows...] and select a folder from the folder selection dialog box

- Enter a full path to the text box

7. For the settings of build, you can select [Enable the project-specific setting that is relating to the setting for building].

[Setting when building] is enabled.
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8. Select [Perform code check when building].

9. When specifying the maximum heap size for Code check, select [Enables project-specific setting related to the setting of the
maximum heap size for Code check].

[Setting of maximum heap size] is enabled.
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10. Specify the numerical value in the [Maximum heap size (MB)] textbox.

2.3 Uninstalling the Plug-in of Agile+ Relief J
To uninstall the plug-in of the Agile+ Relief J, please perform the following operations.

Plug-in of the Agile+ Relief J

The following plug-in of the Agile+ Relief J is stored in "Installation directory of the AgilePlus \PGReliefJava\eclipse\plugins".

com.fujitsu.jp.fst.pgrelief.java.eclipse.doc.detail_x.x.x.jar

com.fujitsu.jp.fst.pgrelief.java.eclipse.doc.guide_x.x.x.jar

com.fujitsu.jp.fst.pgrelief.java.eclipse_x.x.x.jar

*x.x.x refers to the version of plug-in.

<Operations>

1. If Eclipse is running, exit the eclipse.
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2. The plug-in of Agile+ Relief J, which are copied to the plugins folder or the dropins folder of the Eclipse installation folder are deleted.

3. Delete the ".pgrjava" folder of the project in the Eclipse workspace.
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Chapter 3 Code check Procedure
This section describes the procedure of performing Code check using Agile+ Relief J.

3.1 Perform Code check
Perform Code check for the project that is opened. Please make sure that the Code check is performed without any compilation error.

If the auto build is not set, perform the Code check after building.

The Code check can be performed in the following three ways.

- Select a project for Code check

One or more check target projects can be selected from workspace.

A check target project can be selected from the view of Package Explorer, Project Explorer, or Navigator.

If the selected project contains a non-check target project, the [Code check] command will become invalid.

- Select a file for Code check

One or more check target files can be selected from workspace.

A Java file can be selected from the view of the Package Explorer, Project Explorer, Navigator, or Confirmation Status.

If the selected file contains a non-check target file, the [Code check] command will become invalid.

If the editor that opens a check target file is active, the Code check can be performed.

- Perform Code check automatically when building

Because of the synchronization with the building of Eclipse, after a check target file is built, the Code check for the Java file is performed
automatically.

According to the option settings during building, if [Perform code check when building] is selected, the Code check is performed when
the Java file is built.

- Setting method

Please refer to "Setting when building".

After Code check is performed, the views of [Agile+ Relief Message List] and [Agile+ Relief Confirmation Status] are displayed.

In addition, the ".pgrJava" folder is generated in the project folder. The ".pgrJava" folder is used by the Agile+ Relief J. Therefore, please
do not modify this folder.

The following describes how to perform the Code check by selecting the project and file.

3.1.1 Code check from Menu Bar
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Perform Code check for the selected check target project or check target file.

Multiple check target projects or check target files can be selected.

If a project is selected, the Code check is performed for all the check target files of the project.

*If no check target project/check target file is selected, this function will be disabled.

*If a check target project/check target file is selected, this function will also be disabled.

<Operations>

1. Select applicable asset for Code check, perform either of the following operations.

- Select a check target project or check target file from the view of the Package Explorer, Project Explorer, or Navigator.

- The check target file of a check target project are displayed in an editor.

- Select a file from the Confirmation Status view.

2. Select [Agile+ Relief J] menu > [Code check].

3.1.2 Code check from Tool bar

Perform Code check for the selected check target project or check target file.

Multiple check target projects or check target files can be selected.

If a project is selected, the Code check is performed for all the check target files of the project.

*If no check target project/check target file is selected, this function will be disabled.

*If a check target project/check target file is selected, this function will also be disabled.

<Operations>

1. Select an object for Code check, perform either of the following operations.

- Select a check target project or check target file from the view of the Package Explorer, Project Explorer, or Navigator.
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- The check target file of a check target project are displayed in an editor.

- Select a file from the Confirmation Status view.

2. Click the icon of Code check on the tool bar

3.1.3 Code check from Pop-Up Menu

Perform Code check for the selected check target project or check target file.

Multiple check target projects or check target files can be selected.

If a project is selected, the Code check is performed for all the check target files of the project.

*If no check target project/check target file is selected, this function will be disabled.

*If a check target project/check target file is selected, this function will also be disabled.

<Operations>

1. Select a check target project or check target file from the view of the Package Explorer, Project Explorer, or Navigator. A pop-up
menu is displayed.

2. Select [Agile+ Relief J] > [Code check].

3.1.4 Code check from Confirmation Status
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Perform the Code check for the file corresponding to the line selected in the Confirmation Status.

Multiple lines can be selected.

<Operations>

1. Select a file from the Confirmation Status.

2. Right-click the file and select [Code check].

The Code check from Confirmation Status can be performed using menu bar and tool bar.

3.1.5 Display the Process of Code check
During Code check, you can confirm the process of the Code check through the status view.

Click  button at the lower-right corner in the window of Eclipse, and the status view will be displayed.
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When multiple projects are selected, the status of these projects are displayed in percentage on the status bar.

3.2 Confirm Code check Result
Confirm the Code check result through the following views.

Open an applicable check target project and select [Use Agile+ Relief J] from the [Agile+ Relief J] menu.

- Message List

Confirm the messages that are regarded as the check result in the message list (importance degree, confirmed, category, rule code,
message, memo, file name, path name, and line number).

- The Confirmed and Memo items are used for confirmation records of the message.

- The file name, path name, and line number are used for editor interaction.

- Message Detail

Message details (rules, classification, contents to be checked, meanings, and handling methods) can be confirmed.

- Confirmation Status

The Confirmatin Status that is regarded as the check result in the message list (path name, file name, determination, check, and number
of messages) can be confirmed.
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The items of importance degree, category, and unconfirmed are displayed for the number of messages according to the total matrix in
the file unit.

- The file name, path name, and line number are used for editor interaction.

3.2.1 Confirm Messages
The message may be indicated as rule violation during Code check. Messages can be confirmed through the view of Agile+ Relief message
list.

Confirm the message through the following steps.

1. Display message list

2. Confirm messages

3. Confirm message details

4. Confirm the source codes of messages

5. Record the judgment result

6. Record the judgment memo

The messages corresponding to the selected check target project or check target file are displayed in the message list. The confirmation result
of the message can be recorded through the Confirmed and Memo items in the message list.

3.2.1.1 Display Message List
The message list can be linked with the selected project in the following views to display the targeted messages.

- Package Explorer

This view displays the messages relevant to the selected check target project, source folder, package, and check target file.

- Project Explorer

This view displays the messages relevant to the selected check target project, source folder, package, and check target file.

- Navigator

This view displays the messages relevant to the selected check target project, check target file, and folder.

- Confirmation Status

This view displays the messages of the selected file.

The following table describes the actions of selecting project units in the views mentioned above.

 
Item to be selected Description

Project All the messages under the selected projects are displayed.

When multiple projects are selected, the first-selected project will be targeted.

Package All the messages right under package selected are displayed.

When multiple packages are selected, the first-selected package will be targeted.

File All the messages under the selected folders are displayed.

When multiple files are selected, the first-selected file will be targeted.

Source folder All the messages under the selected source folders are displayed.

When multiple source folders are selected, the first-selected source folder will be targeted.

Folder All the messages under the selected folders are displayed.
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Item to be selected Description

When multiple folders are selected, the first-selected folder will be targeted.

In initial state, the Collaborate with other views is enabled.

To perform direct operations on other views, the contents in the message list are directly linked with other views after  (Collaborate with

other views) of the tool bar is off.

 

 Example

- Display the messages based on the project selection from the Package Explorer

After "Project1" is selected from the Package Explorer, the messages corresponding to the Java file of "Project1" will be displayed in
the message list

- Display the messages based on the Java file selection from the Package Explorer

After "GasStand.Java" is selected from the Package Explorer, the messages corresponding to the file will be displayed in the message
list.
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- Display the messages based on the file selection from the confirmation status

After a line in "GasStand.Java" is selected from the confirmation status, the messages corresponding to the file will be displayed in the
message list.

3.2.1.2 Confirm Messages
Confirm the messages according to the message list.

Confirm the messages and number of unconfirmed messages in the message list.

The following table describes the display items of the message list.

Header part
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Item to Be Displayed Description

Project The targeted project name is displayed.

Messages The number of messages of the selected project or file is displayed.

The details of importance degree (!, S, W) is also displayed.

Total Messages The number of messages of all projects is displayed.

The details of importance degree (!, S, W) is also displayed.

List part
 

Item to Be Displayed Description

Importance degree The importance degrees of a rule are displayed in icons. The icons are as follows.

 :"Importance degree: !" indicates that the operating environment error.

 :"Importance degree: S" indicates the most critical rule.

 :"Importance degree: W" indicates the critical rule.

Confirmed Display confirmation status of the messages. This item can be enabled and disabled through
the check box.

Through combination with the filter, it is ok to not display unnecessary information
(confirmed information .etc).

Category Display the rule category.
The rules have following categories.

- Reliability

- Maintainability/Readability

- Efficiency

- Functionality

- Portability

- User rules

- Other (Note 1)

Rule code Display the rule code.

Message Display the contents of rule violation.

Memo Display the contents of memo.

The reasons corresponding to the comments in revision and the messages that are no need to
process can be set as the pending content.

File name Display file name.

Path name Display path name.

Line number Display line number.

(Note 1) Some indication of FindBugs and the PMD may become the categories of "Other".

3.2.1.3 Confirm Message Details
Confirm message details such as problem points and improvement methods.

If the messages whose details need to be confirmed is selected from the message list, the details are displayed in the [Agile+ Relief Message
Detail] view.

In initial state, the Collaborate with other views is enabled.
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To perform direct operations on other views, the contents in the message list are directly linked with other views after  (Collaborate with

other views) of the tool bar is off.

Display content

The following table describes the item to be displayed.

 
Item to Be Displayed Description

Rule code Display the rule codes.

Rule content Display the rule contents.

Category Display the rule category.

Content of check Display the check contents that checking the rules.

Explanation Display the meanings and problem points of the rules.

Measures method Display the handing methods of the rules with instances.

3.2.1.4 Confirm the Source Codes of the Messages
Confirm messages during Code check through the source code.

Through editor interaction, open the source codes of the object that is generated from the message in the editor and locate the message.

If the line number of the message is 0, the editor interaction is performed as follows.

- If the source code of an object is not opened in an editor, open them and locate the first line.

- If the source code of an object is opened in an editor, this editor is displayed directly.

<Operations>
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1. Select a line from the message list and perform either of the following operations.

- Double-click

- Select [Editor Interaction] from the pop-up menu.

Example: double-click a line from the message list to move the focus to the line of the message of the targeted file.

In the marker display area of the editor, rule violations in the Code check result are identified with the marker that indicates the importance
degree of the message.
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Put the mouse cursor on the marker, the content of the message can be displayed. If multiple messages exist in one line, the contents are
displayed collectively.

 

 Information

In Eclipse 3.4, the Agile+ Relief message can be confirmed through the marker view.

3.2.1.5 Record Confirmation Status
Record the confirmation records of the message as the confirmation status.

For the record of conformation status, use the checkbox of [Confirmed] column of the message list. If Confirmed is checked, you can cancel
the check to cancel the confirmation.

When only the message that is not terminated is displayed, the message can be added after the confirmed filter is off.

<Operations>

1. Select the recorded messages from the message list.

2. Record the confirmation status, perform either of the following operations.

- Check or uncheck the [Confirmed] checkbox.

- Select [Mark Confirmed] or [Unmark Confirmed] from the pop-up menu.

When the Code check results after the second Code check are indicated again, the confirmed message may be recorded directly as
confirmed, but if the source code of the message line is different from the previous ones, the check of Confirmed will be cancelled.

3.2.1.6 Record Confirmation Memo
When the memo as confirmation record of message is required, it is recorded as the memo for the conformation of messages.

After the reason for not processing the message is recorded, the part that does not require processing can be known by referring to the memo
when the same contents are indicated during the next Code check. Therefore, the content of the message does not need to be confirmed again.

<Operations>
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1. Select a message.

2. Click the memo column.

The input field is displayed.

3. Enter memo and press the Enter key.

3.2.1.7 Sort Message List
Sort the displayed contents of messages.

The displayed content can be sort by clicking each project name on the header of message list.

Example: When sorting by Rule Code

3.2.1.8 Filtering Message List
Filter according to the condition of the displayed message content.

The filtering conditions contain importance degree, category, and confirmation.

Type of filter
 

Classification Icon Filter items

Importance degree Importance degree:!

Importance degree:S

Importance degree:W

Category Reliability

Maintainability/Readability

Efficiency

Functionality

Portability

User rules

Other

Confirmation Confirmed
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There are three methods for the specification of filtering, which include filtering through the icon of tool bar, view menu, and pop-up menu.

- Specify by icon of tool bar

Select any icon for filtering from the tool bar.

Example: When Importance degree: S, Category: R(Reliability) and M(Maintainability/Readability) are specified

- Specify by view menu

Select any project for filtering from the view menu.

Example: When Importance degree: S, Category: R(Reliability) and M(Maintainability/Readability) are specified

- Specify by pop-up menu

Select any project for filtering from the pop-up menu.
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Example: When Importance degree: S, Category: R(Reliability) and M(Maintainability/Readability) are specified

3.2.2 Confirm Judgment Results
In the confirmation status, the Code check result and the confirmation status of messages are displayed as the following items.

- Judgment result (OK/NG)

- Whether Code check is performed

- Number of unconfirmed messages (importance degree)

- Number of messages (importance degree and category)

When the importance degree is "!" or "S", and the number of unconfirmed messages is greater than one, the confirmation status is displayed
as NG. Otherwise, the confirmation status is displayed as OK.

Please check whether the judgment results of each file are OK or NG in the confirmation of the judgment result, and confirm the messages
for NG files.

3.2.2.1 Display Judgment Results
The judgment results can be selected and linked in the following views, and the judgment results of the applicable assets are displayed.

- Package Explorer

The judgment results that are correspondent to the selected check target project, source folder, package, and check target file are
displayed.

- Project Explorer

The judgment results that are correspondent to the selected check target project, source folder, package, and check target file are
displayed.

- Navigator

The judgment results that are correspondent to the selected check target project, check target file, and folder are displayed.
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The following table describes the actions of the selected items of the views mentioned above.

 
Items to Be Selected Description

Project All the judgment results under the selected projects are displayed.

When multiple projects are selected, the first-selected project will be targeted.

Package The judgment results under the selected packages are displayed.

When multiple packages are selected, the first-selected package will be targeted.

File The judgment results under the selected files are displayed.

When multiple files are selected, the first-selected file will be targeted.

Source folder All the judgment results under the selected source folders are displayed.

When multiple source folders are selected, the first-selected source folder will be targeted.

Folder The judgment results under the selected folders are displayed.

When multiple folders are selected, the first-selected folder will be targeted.

Under initial status, the Collaborate with other views is on.

To perform direct operations on other views, the contents in the message list are directly linked with other views after  (Collaborate with

other views) of the tool bar is off.

 

 Example

- Display according to the project selection from the Package Explorer

After Project1 is selected from the Package Explorer, the confirmation status corresponding to the Java files of Project1 is displayed.
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- Display according to Java file selection from the Package Explorer

After "GasStand.Java" is selected from the Package Explorer, the confirmation status corresponding to "GasStand.Java" is displayed.

3.2.2.2 Confirm Judgment Results
Confirm whether the judgment result is OK or NG in a check target file unit.

In the case of NG, the unconfirmed messages whose importance degree is S or ! are retained. Therefore, please re-examine the applicable
messages in the message list.

The display content is shown as follows.
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Header part
 

Item to Be Displayed Description

Project The name of applicable project is displayed.

List part
 

Item to Be Displayed Description

Path The path name is displayed.

File The file name is displayed.

Judge The judgment for the qualification of the number of unconfirmed messages is
displayed.

"OK": No message in the state of [!: unconfirmed] and [S: unconfirmed]

"NG": The number of messages in the state of [!: unconfirmed] and [S:
unconfirmed] is greater than one

"-": The Code check is not performed, or it is performed for the files that are not
targeted.

Check The implementation status of the Code check is displayed.

"Done": Code check has been performed

"Not yet": Code check is not performed, or the Code check result has already
been cleared

"-": Code check is performed for the files that are not targeted(Note 1)

Unconfirmed The number of unconfirmed messages is displayed.

The messages for which [Confirmed] is not checked in the message list are
counted as unconfirmed messages.

! unconfirmed The number of unconfirmed messages with importance degree ! is displayed.

S unconfirmed The number of unconfirmed messages with importance degree S is displayed.

W unconfirmed The number of unconfirmed messages with importance degree W is displayed.

Messages The total number of messages is displayed.

! Messages The number of messages with importance degree! is displayed.

S Messages The number of messages with importance degree S is displayed.

W Messages The number of messages with importance degree W is displayed.

S Reliability The number of messages with Reliability importance degree S is displayed.

S Maintainability/Readability The number of messages with Maintainability/Readability importance degree S
is displayed.

S Efficiency The number of messages with Efficiency importance degree S is displayed.

S Functionality The number of messages with Functionality importance degree S is displayed.

S Portability The number of messages with Portability importance degree S is displayed.

S User rules The number of messages with User rules importance degree S is displayed.

S Other The number of messages with importance degree S of other is displayed.

W Rreliability The number of messages with Reliability importance degree W is displayed.

W Maintainability/Readability The number of messages with Maintainability/Readability importance degree
W is displayed.

W Efficiency The number of messages with Efficiency importance degree W is displayed.

W Functionality The number of messages with Functionality importance degree W is displayed.
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Item to Be Displayed Description

W Portability The number of messages with Portability importance degree W is displayed.

W User rules The number of messages with User rules importance degree W is displayed.

W Other The number of messages with importance degree W of other is displayed.

(Note 1) The file that is not targeted for Code check refers to the file that matches the condition of [Except file] that is defined by
customizer. For details, please refer to "Agile+ Relief J Customizer Operation Guide".

3.2.2.3 Confirm the Source Codes of the Judgment Result
Confirm the source codes of judgment target through editor.

The targeted files are displayed as follows through editor interaction.

- If the source code of a targeted file is not opened in an editor, open them and locate the first line.

- If the source code of a targeted file is opened in an editor, this editor is displayed directly.

Perform editor interaction through the following procedure.

- Double-click a file name.

Double-click a file name to display the source file.

- Jump from the pop-up menu.

Select [Editor Interaction] from the pop-up menu to display the source file.

3.2.2.4 Sort Judgment Results
The judgment results can be sorted according to the displayed item name.

Click the displayed item name on the header to switch between ascending and descending order of sorting the displayed judgment results.

Example: When sorting according to the number of unconfirmed messages
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3.2.2.5 Filtering Judgment Results
Filter the displayed contents of the judgment results according to the conditions described in the following table.

 
Icon Condition Description

Display only the judgment results that
are NG

Display only the judgment results with [Judge] being "NG".

Display only the judgment results that
are not checked

Display only the judgment results with [Check] being "Not yet".

The setting of filtering can be performed through tool bar, view menu and pop-up menu.

- Filtering from tool bar

Select an icon of condition from the tool bar, and filter the confirmation status according to each condition.

Example: Only the NG judgment results are displayed, and the condition of displaying only the judgment results that are not checked
is not specified.

- Filtering from view menu

Select a condition item from the view menu, and filter the judgment results according to each condition.
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Example: Only the NG judgment results are displayed, and the condition of displaying only the judgment results that are not checked
is not specified.

- Filtering from pop-up menu

Select a condition from the pop-up menu, and filter the judgment results according to each condition.

Example: Only the NG judgment results are displayed, and the condition of displaying only the judgment results that are not checked
is not specified.

3.2.3 Suppressing Collaborate with Other Views
In initial state, the views of [Agile+ Relief Message List], [Agile+ Relief Message Detail], and [Agile+ Relief Confirmation Status] are
linked with other views and can be switched between each other.

To suppress the Collaborate with other views, please perform the following operations.

<Operations>

1. Turn off  (Collaborate with other views) of the tool bar.

3.3 Output Code check Result
Output the Code check result as a file.

Please open an applicable check target project and enable [Use Agile+ Relief J] of the [Agile+ Relief J] menu.
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The Code check result can be output through the views of [Agile+ Relief Message List] and [Agile+ Relief Confirmation Status].

3.3.1 Output Messages
Output the content currently displayed (in the state of being sorted and filtered) of the [Agile+ Relief Message List] view.
The displayed contents of each item are separated by comma and saved in a file in CSV format. The following items are different from the
displayed contents of a view.

- Confirmed

The following contents are output in the following formats according to the operations on the check box.

 
Confirmed Output

Not checked 0

Checked 1

- Message

If the message contains "," and "", the message must be output after being enclosed with double-quote. In addition, messages can be
extended to multiple lines. At this time, messages should be output after being enclosed with double-quote.

<Operations>

1. Display the view menu of the [Agile+ Relief Message List] view, and select [Generate CSV file...].

2. Specify the output name of message (*. csv) in the [Output of messages] dialog box, and select the [Save] button.

 
CSV Output Image

Project: Project1,Messages: 24 (!:0, S:7, W:17), Total Messages: 24 (!:0, S:7, W:17)

Importance degree, Confirmed, Category, Rule code, Message, Memo, File, Path, Line 

s, 0, Reliability, pgj10212, The field variable in the constructor may not be 

initialized. ,,GasStand.java, ...

S,0, Reliability, pgj10212, the field variable in the constructor may not be 

initialized. ,,GasStand.java, ...

s, 0, Reliability, pgj10214, "Clearly initialize all the variables of the static field" is 

violated. ,,GasStand.java,

W,0,Maintainability/Readability, pgj10068, Literal is not described on the left of comparison 

expression. ,,GasStand.java,src/sample/gasst

    ...
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3.3.2 Output Confirmation Status
Output the content (in the state of being sorted and filtered) displayed in [Agile+ Relief Confirmation Status].

The displayed contents of each item are separated by comma and saved in a file in CSV format.

<Operations>

1. Display the view menu of the [Agile+ Relief Confirmation Status] view, and select [Generate CSV file...].

2. Specify the output name of the specified message (*. csv) in the [Output of confirmation status] dialog box, and select the [Save]
button.

 
CSV Output Image

Project: Project1

Path,File,Judge,Check,Unconfirmed,! Unconfirmed, S Unconfirmed, W Unconfirmed, Messages,! Messages, S 

Messages, W Messages, ...

src/sample/gasstand,AutoMobil.java,OK,Done,,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0

src/sample/gasstand,DiscountGasStand.java,OK,Done,,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0

src/sample/gasstand,Fuel.java,OK,Done,,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0

src/sample/gasstand,GasStand.java,NG,Done,,4,0,3,1,4,0,3,1,3,0,0,0,0,0,0,0,1,0,0,0,0,0

src/sample/gasstand,GasStandSimulation.java,NG,Done,,

20,0,4,16,20,0,4,16,0,0,0,0,4,0,0,12,4,0,0,0,0,0

    ...

3.3.3 Copy Messages
Copy the selected messages to the clipboard. Also, multiple messages can be selected at the same time.

<Operations>

1. Select the message to be copied in the [Agile+ Relief Message List] view.
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2. Select [Copy] from the pop-up menu.

3.3.4 Copy Judgment Results
The selected judgment result can be copied to the clipboard. Also, multiple judgment results can be selected at a time.

<Operations>

1. Select the judgment result to be copied from the [Agile+ Relief Confirmation Status] view .

2. Select [Copy] from the pop-up menu.

3.4 Clear Code check Results
Clear the selected check target project Code check result. Multiple check target projects can be selected at a time.

In addition, to use this function, please open an applicable project and select [Use Agile+ Relief J] from the [Agile+ Relief J] menu.

*The information about "Confirmed" and "Memo" corresponding to the message is cleared.

*If no check target project is selected, this function will be disabled.

<Operations>
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1. Select a check target project in the view of Package Explorer, Project Explorer, or Navigator.

2. Perform either of the following operations.

- Select [Agile+ Relief J] > [Clear the check result of selected project].

- Select [Agile+ Relief J] > [Clear the check result of selected project] from the pop-up menu.

3.5 Output Code check Evidence
The evidence of the Code check results are output. There is file as follows of five kinds of output evidence. All evidence files are separated
by comma and saved in a file in CSV format. These are evidences of the source code analysis process by Agile+ Relief J, and it is possible
to take it into the quality management system etc. used.

 
No Evidence File Name Description

1 MessageList.csv The list of the detected message is output.

2 CheckStatus_File.csv The executing state of Code check is output to the unit of the check target file.
In the executing state, there is information on the presence of the execution of
Code check, and the Code check option etc.

3 CheckStatus_Rule.csv The number of detection messages of the rule list and each rule from which the
check is executed is output to the unit of the check target file.

4 Metrics_File.csv Information on the number of lines etc. is output to the unit of the check target
file.

5 Metrics_Func.csv When the check target file is a Java file, information on the number of lines
and the complexity, etc. on each method defined in that is output.

 

 Note

Agile+ Relief J provides the function to output a part of information on the evidence from the view of [Agile+ Relief Message List] and
[Agile+ Relief Confirmation Status]. However, it has the possibility of causing the user's output mistake as the output result is different etc.
according to the state of the filter of the view. On the other hand, such an output mistake does not happen so that the evidence output function
may output all Code check result information without fail. When the Code check result is confirmed to the third party, the use of the evidence
output function is recommended.

 

 Information

In Agile+ Relief J, these evidence file is input, and "Diagnosis report generation tool" that outputs the result of analyzing the information
as a report of the Book-type of Microsoft(R) Office Excel(R) is being offered. Please use "Diagnosis report generation tool" from the start
menu or the start screen(since Windows(R) 8, Windows Server(R) 2012) of Windows.

3.5.1 Output Evidence
The evidence of the verification outcome with Code check of the selected check target project or check target file is output. One or more
check target projects or check target files can be selected. However, the following selections cannot be done.

- check target project and check target file are selected together.

- The files of a different check target project are selected together.

In addition, to use this function, please open an applicable project and select [Use Agile+ Relief J] from the [Agile+ Relief J] menu.

<Operations> Evidence output by check target project selection
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1. Select a check target project in the view of Package Explorer, Project Explorer, or Navigator.

2. Perform either of the following operations.

- Select [Agile+ Relief J] > [Evidence Output].

- Select [Agile+ Relief J] > [Evidence Output] from the pop-up menu.

3. Specify the output folder in the [Evidence Output] dialog box, and click the [OK] button.

4. The output folder is the following.

 
Folder specified by Operation No.3\check target project by Operation No.1

[Example]

 
check target project by Operation No.1 Sample

Folder specified by Operation No.3 C:\AgilePlusReliefEvidence

Output folder C:\AgilePlusReliefEvidence\Sample

<Operations> Evidence output by check target file selection

1. Select a check target file in the view of Package Explorer, Project Explorer, Navigator, or Agile+ Relief Confirmation Status.

2. Perform either of the following operations.

- Select [Agile+ Relief J] > [Evidence Output].

- In case of Package Explorer, Project Explorer, or Navigator, select [Agile+ Relief J] > [Evidence Output] from the pop-up menu.

- In case of Agile+ Relief Confirmation Status, select [Evidence Output] from the pop-up menu.

3. Specify the output folder in the [Evidence Output] dialog box, and click the [OK] button.

4. The output folder is the following.

 
Folder specified by Operation No.3\Name of Eclipse project that check target file by Operation No.1 belongs

[Example]

 
Name of Eclipse project that check target file by Operation
No.1 belongs

Sample

Folder specified by Operation No.3 C:\AgilePlusReliefEvidence

Output folder C:\AgilePlusReliefEvidence\Sample

3.5.2 Format of evidence files
All evidence files are separated by comma and saved in a file in CSV format. The format of each evidence file is explained as follows.

3.5.2.1 FileHeader(Common)
The file header is output to the first four lines of each evidence file. It is a common output to all evidence files. Information on each evidence
is output since the fifth line.

The column of the each line is explained as follows.

 
Line Column Output item Description

1 1 Evidence type It is a string that shows the type of the evidence.
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Line Column Output item Description

Please refer to the explanation of the following each evidence for
the string of the evidence type.

1 2 "Agile+ Relief J" The string recorded left is set.

1 3 Version The version of Agile+ Relief J is set.

1 4 Output date The date(YYYY/MM/DD hh:mm:ss) when the evidence was
output is set.

2 empty line

3 1 "ProjectName" The string recorded left is set.

3 2 Project name The name of Eclipse project to be output is set.

4 empty line

<Example of output>

*MessageList.csv is read by using Microsoft(R) Office Excel(R).

3.5.2.2 MessageList.csv
The list of message detected with Code check of the selected check target project or check target file is output following the file header part.

Because all messages detected with Code check can be confirmed, the action of each message can be verified.

 

 Note

When the result of past Code check remains, the result is output even if "Unchecked" is set to "Check Status" in CheckStatus_File.csv.

<Evidence type>

The following strings are output as Evidence type that is output item in the file header part.

 
MessageList

<Format>

The column header that shows the meaning of each column of the message is output to the fifth line. The detected message is output by each
line since the sixth line. Each column is explained as follows.

 
Column Column Header

Name
Description

1 Confirmed Information on [Confirmed] of [Agile+ Relief Message List] is set.

 
[Confirmed] column value

Unchecked 0

Checked 1

2 File The full path name of the file where the message is detected is set.
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Column Column Header
Name

Description

3 Line The line number where the message is detected is set.

The message of the operating environment error etc. might be related to not a specific
line but the file whole. For that case, 0 is set.

4 Importance degree The Importance degree of the message is set.

5 Rule Code The Rule Code of the message is set.

6 Message The string of message is set.

7 Memo Information on [Memo] of [Agile+ Relief Message List] is set.

8 Tool Either of the following tool names are set as a tool that detects the message.

- Agile+ Relief

- FindBugs

- PMD

*When the evidence is output by using the Code check Results before PGRelief J
2012 autumn, this column is empty.

9 Category Either of the following categories corresponding to the message are set.

- Maintainability/Readability

- Reliability

- Efficiency

- Functionality

- Portability

- User rules

- Operating environment error

- Other

*When the evidence is output by using the Code check Results before PGRelief J
2012 autumn, this column is empty.

<Example of output>

*MessageList.csv is read by using Microsoft(R) Office Excel(R).

3.5.2.3 CheckStatus_File.csv
The list of the executing state of Code check is output to the unit of the check target file following the file header part.

Whether Code check is appropriately executed because presence of the Code check execution and an optional execution environment for
the check etc. can be confirmed can be verified.

<Evidence type>
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The following strings are output as Evidence type that is output item in the file header part.

 
CheckStatus_File

<Format>

The column header that shows the meaning of each column of the check situation is output to the fifth line. The check situation of the check
target file is output by each line since the sixth line. Each column is explained as follows.

 
Column Column Header Name Description

1 File The full path name of the check target file is set.

2 Check Status The execution existence of Code check is set.

 
value Meaning

Unchecked Code check
unexecution.

Checked Code check has
been executed.

- The file that
excludes from
Code check.

Information might be output since column 3 when the value is "Unchecked". It is a
result of Code check before.

3 Check Date The date(YYYY/MM/DD hh:mm:ss) when Code check was executed is set.

*This column is a blank when the evidence is output by using the Code check Results
before PGRelief J 2012 autumn or the file that excludes from Code check.

4 Agile+ Relief Version The version of Agile+ Relief J when Code check is executed is set.

*This column is a blank when the evidence is output by using the Code check Results
before PGRelief J 2012 autumn or the file that excludes from Code check.

5 Check Options The options specified with Code check is set.

*This column is a blank when the evidence is output by using the Code check Results
before PGRelief J 2012 autumn or the file that excludes from Code check.

6 Java Version The version of Java that Agile+ Relief J operated at Code check is set.

*This column is a blank when the evidence is output by using the Code check Results
before PGRelief J 2012 autumn or the file that excludes from Code check.

7 FindBugs Version When cooperation with FindBugs is effective, the version of FindBugs is set.

*This column is a blank when the evidence is output by using the Code check Results
before PGRelief J 2012 autumn or the file that excludes from Code check.

8 FindBugs Check
Options

The option of FindBugs specified when cooperating with FindBugs is set.

*This column is a blank when the evidence is output by using the Code check Results
before PGRelief J 2012 autumn or the file that excludes from Code check.

9 PMD Version When cooperation with PMD is effective, the version of PMD is set.

*This column is a blank when the evidence is output by using the Code check Results
before PGRelief J 2012 autumn or the file that excludes from Code check.

10 PMD Check Options The option of PMD specified when cooperating with PMD is set.

*This column is a blank when the evidence is output by using the Code check Results
before PGRelief J 2012 autumn or the file that excludes from Code check.
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<Example of output>

*CheckStatus_File.csv is read by using Microsoft(R) Office Excel(R).

3.5.2.4 CheckStatus_Rule.csv
The number of detection messages of the rule list and each rule from which the check is executed is output to the unit of the check target file
following the file header part.

Because the checked rules and the unchecked rules can be confirmed, it can be verified whether there is rule of the check leakage.

 

 Note

When the result of past Code check remains, the result is output even if "Unchecked" is set to "Check Status" in CheckStatus_File.csv.

<Evidence type>

The following strings are output as Evidence type that is output item in the file header part.

 
CheckStatus_Rule

<Format>

The number of messages is output on the matrix format of the rule code and the check target file since the fifth line. Each column is explained
as follows.

 
Column Column Header Name Description

1 Rule The rule code is set.

The rule of FindBugs and PMD is set bringing each tool together.

2 Outline The content of the rule is set.

When the rule code is FindBugs or PMD, it is not set.

Since 3 FilePathName The full path name of all check target files is set since column 3.

The number of messages is set to the column corresponding to the rule code and the check target file. The value of the following 2 varieties
is set to the number of messages.

 
value Meaning

Numerical value of 0 or more It is a detected number of messages.

Empty column It is a rule code not checked at Code check of the check target file.

*In the following cases, the rule code from which the check is executed becomes a empty
column.

- The evidence is output by the result of Code check before PGRelief J 2012 autumn.

- Rule code whose detected number of messages is 0.
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It explains by using the following output images.

File_1 means the message of pgj10000 is 0 and the message of pgj10002 is 1. On the other hand, the check on pgj10002 is not executed
though one message of pgj10000 has been detected in File_2.

[Output image]

 
Rule Outline File_1 File_2 File_3 ・・・ File_n

pgj10000 File name is "class name. java" or "interface name.
java".

0 1 0 1

pgj10002 File name is case-sensitive. 1 0 1

<Example of output>

*CheckStatus_Rule.csv is read by using Microsoft(R) Office Excel(R).

3.5.2.5 Metrics_File.csv
The list of information concerning the number of lines of file and the number of methods (At the Java file) is output to the unit of the check
target file following the file header part.

Productivity and maintainability, etc. can be verified from information on the scale like the number of lines etc.

 

 Note

- When the result of past Code check remains, the result is output even if "Unchecked" is set to "Check Status" in CheckStatus_File.csv.

- Metrics_File.csv cannot be output from the result of Code check before PGRelief J 2012 autumn. Please output the evidence after
executing Code check since PGRelief J 2013 when Metrics_File.csv is necessary.

- Metrics information on the file (XML file, JSP file, StyleSheet file, ECMAScript file, PLSQL file, Apache Velocity file) that becomes
an input of PMD is not output.

<Evidence type>

The following strings are output as Evidence type that is output item in the file header part.

 
Metrics_File

<Format>

The column header that shows the meaning of each column of the metrics information is output to the fifth line. The metrics information
of the check target file is output by each line since the sixth line. Each column is explained as follows.

 
Column Column Header Name Description

1 File The full path name of the check target file is set.

2 All Step Size The number of lines including the null line and the commentline are set.
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Column Column Header Name Description

3 Executed Step Size The number of lines except the null line and the commentline are set.

When the check target file is xml file, the same value as the total number of lines is set.

4 Number of Methods The number of methods defined in the file is set.

When the check target file is xml, 0 is set.

<Example of output>

*Metrics_File.csv is read by using Microsoft(R) Office Excel(R).

3.5.2.6 Metrics_Func.csv
The list of information on the Java methods of the number of lines and the complexity, etc. is output following the file header part about
the Java file output in Metrics_File.csv.

Maintainability and readability, etc. can be verified.

 

 Note

- When the result of past Code check remains, the result is output even if "Unchecked" is set to "Check Status" in CheckStatus_File.csv.

- Metrics_File.csv cannot be output from the result of Code check before PGRelief J 2012 autumn. Please output the evidence after
executing Code check since PGRelief J 2013 when Metrics_File.csv is necessary.

- Metrics information on the file (XML file, JSP file, StyleSheet file, ECMAScript file, PLSQL file, Apache Velocity file) that becomes
an input of PMD is not output.

<Evidence type>

The following strings are output as Evidence type that is output item in the file header part.

 
Metrics_Func

<Format>

The column header that shows the meaning of each column of the metrics information is output to the fifth line. The metrics information
of the Java method is output by each line since the sixth line. Each column is explained as follows.

 
Column Column Header Name Description

1 File The full path name of the check target file is set.

2 Line The line number of the method is set.
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Column Column Header Name Description

3 Method The method name to be gathered metrics is set.

4 All Step Size The number of lines including the null line and the commentline are set.

5 Executed Step Size The number of lines except the null line and the commentline are set.

6 Nesting Levels The maxima of the nest by if statement, while statement, do-while statement, for
statement, switch statement, try statement, synchronized statement, and block is set.

7 Complexity 1 The value which added 1 to the sum total of if1, while1, dowhile1, for1 and switch1
is set.

8 Complexity 2 The value which added 1 to the sum total of if2, while2, dowhile2, for2 and switch2
is set.

9 return The total of the return statement is set.

10 break The total of the break statement is set.

11 continue The total of the continue statement is set.

12 if1 The total of the if statement is set.

13 while1 The total of the while statement is set.

14 dowhile1 The total of the do-while statement is set.

15 for1 The total of the for statement is set.

16 switch1 The total of the switch statement is set.

17 if2 Total in which the number of "&&" and "||" in conditional expression of the if
statement is considered is set. For instance, it counts with two for "if( A && B )". if1
is counted with one.

18 while2 Total in which the number of "&&" and "||" in conditional expression of the while
statement is considered is set. For instance, it counts with two for "while( A && B )".
while1 is counted with one.

19 dowhile2 Total in which the number of "&&" and "||" in conditional expression of the do-while
statement is considered is set. For instance, it counts with two for "while( A && B )".
do-while1 is counted with one.

20 for2 Total in which the number of "&&" and "||" in conditional expression of the for
statement is considered is set. For instance, it counts with two for "for( ; A && B ; )".
for1 is counted with one.

21 switch2 The total of the case statement and the default statement is set.

<Example of output>

*Metrics_Func.csv is read by using Microsoft(R) Office Excel(R).

3.6 Share Code check result
The code check result (include the state of the confirmation and the confirmation memo) is shared among the developers.
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The code check result is shared by the following operation.

1. The shared code check result is exported.

2. The shared code check result is imported.

Other developers' code check results can be shared, and the time of the re-analysis can be reduced. Moreover, the result of the confirmation
allotting it among the developers can be consolidated.

3.6.1 Export Code check result
Export the selected check target project's code check result or the selected check target file's code check result. However, the following
selections cannot be done.

- One or more check target projects are selected.

- Check target project and check target file are selected together.

- The files of a different check target project are selected together.

When you use this operation, open a check target project and select [Use Agile+ Relief J] from the [Agile+ Relief J] menu.

<Operations> when do exporting of the code check result of selected check target project

1. Select a check target project in the view of Package Explorer, Project Explorer, or Navigator.

2. Perform either of the following operations.

- Select [Agile+ Relief J] menu > [Export the check result].

- Select [Agile+ Relief J] menu > [Export the check result] from the pop-up menu.

3. In the [Export the check result] dialog, specify the exporting file name(*.pgrjres), and click the [Save] button.

<Operations> when do exporting of the code check result of selected check target file

1. Select one or more check target file in the view of Package Explorer, Project Explorer, Navigator, or the views of [Agile+ Relief
Confirmation Status].

2. Perform either of the following operations.

- Select [Agile+ Relief J] menu > [Export the check result]

- Select [Agile+ Relief J] menu > [Export the check result] from the pop-up menu, when the operation is executed in the view of
Package Explorer, Project Explorer, or Navigator.

- Select [Export the check result] from the pop-up menu, when the operation is executed in the views of [Agile+ Relief
Confirmation Status].

3. In the [Export the check result] dialog, specify the exporting file name(*.pgrjres), and click the [Save] button.

3.6.2 Import Code check result
Import the selected check target project's code check result and check target file's code check result. However, the following selections
cannot be done.

- One or more check target projects are selected.

- Check target project are check target file are selected together.

- The files of a different check target project are selected together

When you use this operation, open a check target project and select [Use Agile+ Relief J] from the [Agile+ Relief J] menu.
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<Operations> when do importing of the code check result of selected check target project

1. Select a check target project in the view of Package Explorer, Project Explorer, or Navigator.

2. Perform either of the following operations.

- Select [Agile+ Relief J] menu > [Import the check result].

- Select [Agile+ Relief J] menu > [Import the check result] from the pop-up menu.

3. In the [Import the check result] dialog, specify the importing file name(*.pgrjres), and click the [Open] button.

<Operations> when do importing of the code check result of selected check target file

1. Select one or more check target file in the view of Package Explorer, Project Explorer, or Navigator.

2. Perform either of the following operations.

- Select [Agile+ Relief J] menu > [Import the check result].

- Select [Agile+ Relief J] menu > [Import the check result] from the pop-up menu, when the operation is executed in the view of
Package Explorer, Project Explorer, or Navigator.

- Select [Agile+ Relief J] menu > [Import the check result] from the pop-up menu, when the operation is executed in the views of
[Agile+ Relief Confirmation Status].

3. In the [Import the check result] dialog, specify the importing file name(*.pgrjres), and click the [Open] button.

 

 Note

- When the code check result exists in the selected check target file, the dialog that selects the importing method is displayed. Select
either of the following importing methods.

 
Import method Operation

Replace all The code check result (include the confirmation and the confirmation
memo) is replaced.

Replace only confirmed
information and comment.

Only the state of the confirmation and the confirmation memo are replaced
with message of the importing destination.

- The message that importing is not done by the source modification and the source deletion, etc. is output to the file of the csv form.
The log file is output to the same folder as the importing check result file.

<File Name>
 
ProjectName_import_yyyyMMddhhmmss.log

<Format>

The column header that shows the meaning of each column is output to the 1st line. The message of each line that importing is not
done is output since the 2nd line. Each column is explained as follows.

 
Column Column Header

Name
Description

1 Confirmed Information on [Confirmed] of [Agile+ Relief Message List] is set.

 
[Confirmed] column value

Unchecked 0

Checked 1

2 Rule Code The Rule Code of the message is set.

3 Message The string of message is set.

- 50 -



Column Column Header
Name

Description

4 Memo Information on [Memo] of [Agile+ Relief Message List] is set.

5 FileName The name of the file where the message is detected is set.

6 FilePath The path of the file where the message is detected is set.

7 Line The line number where the message is detected is set.

3.7 Help Display

3.7.1 Display Index
The help index is displayed.

<Operations>

1. Select Help from [Help] > [Help Contents].

2. Select [Agile+ Relief J Code check Operation Guide] from the index.

3.7.2 Display Related Topic
The topic related to the following views can be displayed.

- Agile+ Relief Message List

- Agile+ Relief Message Detail

- Agile+ Relief Confirmation Status

- Preferences- [Agile+ Relief J]

- Properties for Project - [Agile+ Relief J]

<Operations>

1. Press the [F1] key in view with focus state.

Related topics are displayed.
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Example: When [F1] key is pressed in the message list.
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Chapter 4 How to Use Code check
This chapter describes the operations of Agile+ Relief J and the order of using samples. The samples stored in the folder "Agile+ Relief
installation folder\PGReliefJava\sample\JavaProject" can be used.
The codes that violate rules are recorded in the Java source code of samples in advance. The following sample is taken as an example to
describe the procedure from performing Code check, to confirming and outputting results.

Sample

- Storage path: C:\Program Files\AgilePlus\PGReliefJava\sample\JavaProject

- Project: Project2

4.1 Prepare Sample Project
Create a sample project on Eclipse.

1. Select [Import...] from the [File] menu of Eclipse. The [Import]-[Select] wizard is displayed.

2. Select [General]-[Existing Project into Workspace] from the [Select an import source], and click [Next >] button. The [Import]-
[Import Projects] wizard is displayed.

3. Specify C:\Program Files\AgilePlus\PGReliefJava\sample\JavaProject for the folder by [Select root directory] textbox.

4. Select Project2 from project, and click the [Finish] button.

After copying the sample to the work space, select [Copy project into workspace] checkbox.

Build the project after it has been created.

4.2 Activate Agile+ Relief J
Activate [Use Agile+ Relief J] from the [Agile+ Relief J] menu, Agile+ Relief J can be used.

After the Agile+ Relief J is activated, the views of [Agile+ Relief Message List], [Agile+ Relief Message Detail], and [Agile+ Relief
Confirmation Status] are displayed.

4.3 Perform Code check
Perform Code check for the sample project.

Select Project2 from Package Explorer, and select [Code check] from the [Agile+ Relief J] menu, the Code check will start.
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After the Code check has completed, the check result is displayed in the views of [Agile+ Relief Message List] and [Agile+ Relief
Confirmation Status].

4.4 Confirm Messages
Confirm accusation messages that are set as the Code check result.

After Project2 is selected from Package Explorer, the message corresponding to the java source code of Project2 is displayed in the [Agile
+ Relief Message List] view.
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4.5 Confirm Message Details
Confirm message details, including the rules, category, contents to be checked, meanings, and handling methods.

After the message of pgj10242 is selected from the [Agile+ Relief Message List] view, details about pgj10242 are displayed in the [Agile
+ Relief Message Detail] view.
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4.6 Confirm Source Codes
Open an editor and confirm the messages of the source code.

Click the message line of pgj10242 in the [Agile+ Relief Message List] view, and the message line of "Main.java" will be located and
displayed in the editor. Also, marker will be attached to indication location on the editor.
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4.7 Modify Source Codes
Correct the indication location of source code according to the message and message detail.

Pgj10242 is a rule that does not invoke System.exit(). Therefore, the run () method of Main class will be invoked instead of the System.exit()
method. When the return value is not 0, output messages and correct it to returned.
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Save the source and perform Code check again.

The modification of messages can be confirmed.

4.8 Record Confirmation and Abstracts
Perform responsive actions for a new message.

This message is not for standard output. However, the current program is proposed for standard output.

Therefore, actions of correct the message is not needed.

Select the [Confirmed] checkbox and recode reasons in the [Memo] column.
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If  (indicating the confirmed state) on the tool bar is disabled, the messages for which the [Confirmed] checkbox is selected will not be

displayed. By performing this operation, displaying only the important messages is enabled, and efficient confirmation can be performed.

4.9 Confirm Judgment Results
The responsive action state of messages can be confirmed in the [Agile+ Relief Confirmation Status] view.

Confirm the [Judge] column and [Check] column.

For the source that is NG in the [Judge] column, please confirm the messages in the [Agile+ Relief Message List] view and correct them.

For the source that is [Not yet] in the [Check] column, please perform Code check and confirm the judgment result.

4.10 Output Message Result
After all messages are corrected, output the message results as a file, and use as a supplementary document for reviewing.

To review all the results, please output the message results when the filter setting of the view is used to display all results.

Output Message list

Select [Generate CSV file...] from the view menu of the message list and specify the output destination in the [Save As...] dialog box.
Please turn on all the filter items for displaying all the messages.
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Output Judgment Results

Select [Generate CSV file...] from the view menu of Confirmation Status and select the output destination in the [Save As...] dialog box.
Please turn off all the filter items for outputting all the judgment results.

4.11 Output Evidence
When the action of the message detected with Code check is completed, the evidence is output.

The evidence is used to confirm Code check is properly executed by the program review etc.

Select Project2 from Package Explorer, and select [Evidence Output] from the [Agile+ Relief J] menu, the evidence output will start.
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Chapter 5 Operating Environment Error
The following lists shows the meaning and responsive actions for operating environment errors that are notified by Agile+ Relief J.

When the operating environment error occurs, Agile+ Relief J interrupts processing to the demanded operation. Please execute a similar
operation again after solving the operating environment error referring to the following.

 
Table 5.1 List of Operating Environment Errors

Code Message Character String Meaning Responsive Action

ERR001 Error occurred during check
operation.

Exception occurred in Agile+ Relief
J.

Please contact the inquiry window of our
company.

ERR002 Insufficient memory. The memory was not enough during
the execution of Agile+ Relief J.

- Please specify the larger value as the
maximum heap size for code check, and
execute again.

- Please reduce the number of sources
being targeted for code check, and
execute again.

ERR003 Agile+ Relief J installation
environment error.

Installation environment of Agile+

Relief J may be destroyed.
Please re-install Agile+ Relief J.

ERR004 JDK environment setting
(JAVA_HOME) error.

- JDK is not installed.

- The environment variable
JAVA_HOME is not set or the
setting includes an error.

- Please install JDK.

- Please set the environment variable
JAVA_HOME.

ERR100 Failed to input file. - No privilege to read the Java source
file.

- The specified encoding is different
from the encoding of the Java source
file.

- Please confirm the existence of the file,
access privilege and network, and make
the file into readable state.

- Please change the encoding of the file
to the encoding that is supported by
Agile+ Relief J.

ERR101 Failed to parse the file. A syntax error is detected in Java
source codes.

Please correct the syntax error, and
execute code check again.

ERR102 The class library that is
necessary for parsing is not
found.

Specification of class library is
insufficient.

Please specify all the necessary class
libraries.

ERR103 The file to be checked is not
found.

- The specified file does not exist.

- The file to be checked under the
specified project does not exist.

- The specified project folder does
not exist.

Please confirm the existence of the file
and the folder.

ERR104 Class file is not found. Class file is not found. Please build the Java source code as a
targeted for check, and create the class
file.

ERR105 Failed to input/output work
file.

- There is no privilege for reading/
writing.

- The disk capacity is insufficient.

- The network is cut off.

Please confirm the access privilege of
the target folder and disk capacity, and
change it into readable/writable state.

ERR106 Class file may not be the latest
version. Please build the Java

Class file may not be the latest
version.

Please build the Java source code as a
targeted for check, and create the class
file.
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source code as a targeted for
check, and create the class file.

ERR203 Failed to output the check
result.

- There is no privilege for reading/
writing.

- The disk capacity is insufficient.

- The network is cut off.

- Multi byte character is used for the
Java identifier. (Using PMD
cooperation)

- Please confirm the access privilege of
the target folder and disk capacity, and
change it into readable/writable state.

- Please do not use the PMD cooperation
when Multi byte character is used for the
Java identifier. For details, refer to "B.4
Troubleshooting".

ERR204 Encoding specification error. The specified encoding is not
supported.

Please specify the encoding that is
supported by Agile+ Relief J.

ERR205 The format of check rule
definition file is incorrect.

- code=001
The specified path does not exist.

- code=002
A higher version of a check rule
definition file or a non-check rule
definition file is specified.

Please specify a correct "Check rule
definition file".

ERR500 Error occurred during check
operation of the cooperation
tool.

Please check the error details at
console.

By executing FindBugs or PMD, an
error occurred.

Please confirm the console and handle
the error according to the error message
output by the cooperation tool.

ERR501 Failed to start the cooperation
tool.

Definition of "plugins.xml" has an
error.

Please confirm the definition of
"plugins.xml".

ERR502 "plugins.xml" definition error. Format of "plugins.xml" has an
error.

Please confirm the format of
"plugins.xml".

ERR900 Error has been detected in the license management system.

Please handle it according to "Messages and disposal of license management system" of "Installation Guide".
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Chapter 6 Cautions

6.1 Code check

- About Environment Variables

The environment variable JAVA_HOME must be registered. Please register the path of JDK that is used to JAVA_HOME.

- About the Java File Can Be Checked

- The Java program in conformity with Java Language Specifications of JDK 1.4/5.0/6/7/8 applies.

- A Java program using assert or enum as identifiers cannot be checked.

- A Java file contains more than 5,000 lines cannot be checked.

- If the character code is not Cp1252 or UTF-8, the check cannot be performed correctly.

- If the path name of a file contains more than 259 characters, this file cannot be read normally.

- If the filename of a file contains more than 255 characters, this file cannot be read normally.

- The Code check cannot be performed for anonymous class or local class.
Therefore, when variables and methods are defined in an anonymous class or a local class, they are detected as rule violation.

- If the line feed code is not CRLF, a code check is not executed definitely.

- Please specify the Java file that has no error to check.

- About class file

- The code check needs class file. Please build the Java source code as a targeted for check, and create the class file.

- In a compile time, please specify the following options by all means. When the following options are not specified, the code check
is not executed definitely.

<The option of the "javac" command>

-g:source,lines

< Setting in Eclipse>

Please check the following in [Properties]-[Java Compiler] of the project.

- Add line number attributes to generated class files (used by the debugger)

- Add source file name to generated class file (used by the debugger)

- About Output of Result File

If the message "Failed to output the result file" is displayed during Code check, please confirm the writing privilege and disk capacity
of the notified folder.

- About Memory Insufficiency

The message "Out of memory." is displayed during Code check for the project of large-scale development asset.

[Prevention method]

After the maximum heap size is specified to a value more than default (more than 256 MB is recommended), start Eclipse.
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- In case of Eclipse

Specify "-vmargs -Xmx256M" in the startup option of Eclipse.

For details on the startup option, please refer to "Workbench User Guide"-"Tasks"-"Running Eclipse" from the Help of Eclipse.

- About the case that cannot be correctly detected

- In the case of no declaration between file initial comment and class comment

For the code without declaration between file initial comment and class comment, it will be indicated incorrectly by rule pgj10075.

<Example>

In the following program example, no declaration like import statement exists between file initial comment and class comment.
Therefore, the class comment in the sixth line will be recognized as file initial comment, and because there is "/**", the code is
indicated as a violation of rule pgj10075.

Rule pgj10075: The header comment must be described at the initial part of source.

 1   /*

 2    * file name : MyClass.java

 3    * ...

 4    */

 5

 6   /**  <- Incorrectly indicated as violation of rule pgj10075

 7    * class name : MyClass

 8    * ...

 9    */

10   public class MyClass {

11       :

12   }

6.2 Eclipse Operation

- About the Startup Option of Eclipse

After updated the plug-ins of Agile+ Relief J, use the "-clean" option to start Eclipse.

- About the Link Asset

- The source files linked in Eclipse project are not targeted for Code check. Please arrange the asset to the sub folder of the Eclipse
project folder.

- When created a Java project by selecting [Java Project from Existing Ant buildfile] from Create New Project, the applicable asset
will be linked and become not applicable for Code check. Therefore, please create the Java project not by using the existing Ant
build file.

- About Build Settings

The option of automatic check after building ([Window] > [Preferences] > [Agile+ Relief J] > [Setting when building]) is only effective
for the project that is being configured.

The settings are not applicable for new projects. Therefore, when a new project is added, perform the settings for building again.
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- About Display Switch

If there are too many Code check results to display, the switch between [Agile+ Relief Message List] view and [Agile+ Relief
Confirmation Status] view will be time-consuming.

- About Result Display

If the result for Code check is not displayed in the [Agile+ Relief Message List] view or [Agile+ Relief Confirmation Status] view,
please confirm the following content.

- Selection of applicable asset

Select applicable asset (project or Java file) from the view of Package Explorer, Project Explorer, or Navigator.

- Synchronization with other views

Turn on  (synchronize with other views) from the toolbar of [Agile+ Relief Message List] view or [Agile+ Relief Confirmation

Status] view to achieve the synchronization with other views and select the applicable asset again.

- Filter

Set the filter of [Agile+ Relief Message List] view and [Agile+ Relief Confirmation Status] view again.

- About Message List

Even if the Code check is performed again, the contents of the [Confirmed] and [Memo] columns in the message list can be
interconnected. However, contents may not be interconnected in the following cases.

- When the messages are corrected, and the contents are not indicated in next Code check

- When the file name is modified

- When the file is moved

- When the project name is modified

- About Editor Interaction

- If the file cannot be displayed due to operating environment error, the editor cannot be interaction.

- If  (synchronize with other views) in the [Agile+ Relief Message List] view or [Agile+ Relief Confirmation Status] view is off,

and the project to be displayed is closed, the editor interaction cannot be performed.

- About the Marker of Editor

When modifying project name through refactoring, the result of the Code check before modification cannot be displayed correctly.

At this time, please perform Code check again after clearing the check results.

- About the Output of Code check Results

It can output CSV file from the [Agile+ Relief Message List] view or [Agile+ Relief Confirmation Status] view. If the number of CSV
file exceeds 65535 lines, this file cannot be opened through Excel. (May be able in some version of Excel)

- About the Case required for Next Code check

After the following operations are performed, the information about the [Marker], [Confirmed], and [Memo] cannot be set again
normally. This is because this part of source is deleted during modification.
In this case, please perform Code check again.

- Synchronous processing (such as Commit/Update) with configuration management (such as CVS .etc)
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- Configuration change of the Eclipse

- Change of source folder name, package name, folder name, and file name

- Moving of source folder, package, folder, and file

- Direct change through the tools except Eclipse

- Change of source folder name, package name, folder name, and file name

- Moving of source folder, package, folder, and file

- Change of the file name or file contents

When the following contents are modified, the integrity with the applicable asset of Code check and the Code check result cannot be
achieved. Therefore, please perform Code check again after clearing the check results.

- Moving the workspace

- Modifying the project name

- Moving a project

- Replacing the check rule definition file outside the Eclipse

- About the Processing Operations

During Code check or result reading, the functions of Agile+ Relief J are disabled.
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Appendix A About cooperation with FindBugs
This appendix describes the FindBugs cooperation function of Agile+ Relief J and how to use the function.

A.1 What is FindBugs cooperation?
By FindBugs cooperation, the indication of FindBugs can be operated from Agile+ Relief J by cooperation with the sFindBugs which is the
static analysis tool of open source.

FindBugs cooperation provides the following functions.

- FindBugs is automatically executed at the time of code check operation.

- The indication of FindBugs can be confirmed in the [Agile+ Relief Message List] view.

- Indication details of FindBugs can be confirmed in the [Agile+ Relief Message Detail] view.

By using FindBugs cooperation, code check can be enhanced and quality can be improved.

A.2 Using FindBugs
To use FindBugs, it is necessary to operate according to the following procedure.

<Operations>
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1. Install FindBugs

Download the distributed material from the public website (http://findbugs.sourceforge.net/) of FindBugs. Please refer to ReadMe.txt
under the folder "Agile+ Relief installation folder \PGReliefJava" for the target version.

Unzip the distributed material that has been downloaded to any folder.

2. Prepare the "plugins.xml" file

Rename the model file of plugin file under the folder "Agile+ Relief installation folder\PGReliefJava" from "plugins.xml.tools" to
"plugins.xml".

When the existing plugin file is being renamed based on the setting of PMD cooperation this operation is unnecessary.

3. Edit the "plugins.xml" file

Here, edit according to the following procedure.

- Enable/Disable FindBugs cooperation

- Define the file path of FindBugs command

- Define FindBugs command options

The <plugin> tag after the following comment in the "plugins.xml" file is the definition of FindBugs cooperation.

Following is the detail of definition content.

Definition content
 

Definition item Tag Attribute Content of Configuration

Tool cooperation flag plugin enable Enable/Disable FindBugs cooperation.

FindBugs command command executable Define the file path of FindBugs command.

FindBugs command
option

arg value Define FindBugs command options.

Tool cooperation flag

The FindBugs cooperation can be enabled or disabled by changing the tool cooperation flag. It can specify "true" of "false" to the
value of the "enable" attribute of the <plugin> tag.

[When FindBugs cooperation is enabled]

 
<plugin id="findbugs" name="FindBugs" class=" ..... " enable="true">

[When FindBugs cooperation is disabled]

 
<plugin id="findbugs" name="FindBugs" class=" ..... " enable="false">
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FindBugs command

Specify an execution file (batch file) of FindBugs which is saved in installation folder of FindBugs.

 
<command executable="FindBugs installation folder\bin\findbugs.bat">

FindBugs command option

Specify a FindBugs option to be passed to the execution file of FindBugs. The option specifies the combination of option name
and the parameter by <arg> tag. In case of no parameter, only specify the option name by <arg> tag.

Example) Specify the "-maxHeap 512" option

 
<arg value="-maxHeap"/>

<arg value="512"/>

The option is defined in plugins.xml file in advance. Please modify it if necessary. However, for the option that is the comment
such as <!-- unchangeable -->, please do not modify or delete it.

The trouble happens to the operation of FindBugs because the limit of the character length of command line of FindBugs is
exceeded when you specify a lot of reference class libraries.

Change a command option as follows when you specify a lot of reference class libraries by using since FindBugs3.0.0.

[Old]

 
<arg value="-auxclasspath" if="lib_path"/> <!-- Unchangeable (Specification of reference class library) -->
<arg value="{lib_path}" quote="true" if="lib_path"/> <!-- Unchangeable (Specification of reference class
library) -->

[New]

 
<arg value="-auxclasspathFromFile" if="lib_path_file"/> <!-- Unchangeable (Specification of reference class
library) -->
<arg value="{lib_path_file}" quote="true" if="lib_path_file"/> <!-- Unchangeable (Specification of reference
class library) -->
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4. Execute FindBugs

Execute FindBugs by operating the code check of Agile+ Relief J.

In addition, the editing process of plugins.xml should be ended before using Agile+ Relief J. If the plugins.xml is edited in the process
of using Agile+ Relief J, please stop the usage of Agile+ Relief J through [Agile+ Relief J] - [Use Agile+ Relief J] menu, and set it to
usage state again.

5. Confirm the result of FindBugs

The messages of FindBugs are mapped in the format of the messages of Agile+ Relief J and can be confirmed in [Agile+ Relief
Message List] view and [Agile+ Relief Message Detail] view.

A.3 Mapping of FindBugs Messages
The messages of the FindBugs are converted into categories of Agile+ Relief J according to the mapping rule of the following categories,
and displayed in the [Agile+ Relief Message List] view.

Category

In "plugins.xml.tools" that is the model file of plugin file, the relation between the FindBugs category and the Agile+ Relief J category
is defined as shown in the following tables. The FindBugs category that has not been described in the table is associated with "Other"
of the Agile+ Relief J category.

 
Table A.1 Mapping of FindBugs category and Agile+ Relief J category in "plugins.xml.tools"

FindBugs Agile+ Relief J (Display format in Message List)

Bad practice Reliability

Performance Efficiency

Correctness Reliability

Internationalization Portability

Multithreaded correctness Reliability

Malicious code vulnerability Functionality

Dodgy Maintainability/Readability

Security Functionality

Experimental Other

This relation is defined with <option> tag in plugin file (plugins.xml) as follows in each category. The relation can be customized by
changing this definition.

 
<option id="category.FindBugs category name" value="Agile+ Relief J category name"/>

Example) "BAD_PRACTICE" of FindBugs is associated with "Reliability" of Agile+ Relief J.

 
<option id="category.BAD_PRACTICE" value="CATEGORY_RELIABILITY"/>

The category name of Agile+ Relief J must use the following.

 
Table A.2 Agile+ Relief J category name

Agile+ Relief J category name Meaning

CATEGORY_MANITAINABILITY Maintainability/Readability

CATEGORY_RELIABILITY Reliability
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Agile+ Relief J category name Meaning

CATEGORY_EFFICIENCY Efficiency

CATEGORY_FUNCTIONNALITY Functionality

CATEGORY_PORTABILITY Portability

CATEGORY_OTHER Other

Importance degree

The importance degree is defined as shown in the following tables. It is not possible to change.

 
Table A.3 Mapping of FindBugs importance degree and Agile+ Relief J importance degree

FindBugs Agile+ Relief J (Display format in Message List)

high-priority warning Importance degree: S

medium-priority warning Importance degree: W

low-priority warning Importance degree: W

A.4 Troubleshooting
This section describes the problems that frequently occur in FindBugs interaction and responsive actions.

- The following errors are displayed during code check

Please confirm the errors according to the content output to the console and by referring to the Manual of FindBugs.

The errors that occur frequently are shown as follows according to example of output to the [Console] view.

- Option errors of FindBugs is displayed

When the invalid option is specified for the command parameter of FindBugs, the following option errors are displayed. Please
confirm the command parameter in the configuration file for plugin (plugins.xml), and perform the code check again after
modifying it to the correct one.

Example of output from console (When -maxHea instead of -maxHeap is specified)

plugin: FindBugs

FindBugs: Unknown option: -maxHea

FindBugs: Usage: findbugs [general options] -textui [command line options...] [jar/zip/class 

files, directories...]

FindBugs: General options:

FindBugs:   -gui             Use the Graphical UI (default behavior)

FindBugs:   -gui1            Use the older Graphical UI

FindBugs:   -textui          Use the Text UI

    :
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- Insufficient memory of FindBugs is displayed

This error is displayed when the memory is insufficient during the execution of FindBugs. Please specify the memory space
required for parsing through the command parameter (-maxHeap option) in the configuration file for plugin (plugins.xml).

Example of output from the console

plugin: FindBugs

FindBugs: Out of memory

FindBugs: Total memory: ...

FindBugs:  free memory: 0M

FindBugs: Analyzed: D:\Work\CT_Security\PGRJava_CodeRev_Engine\bin

FindBugs: Exception in thread "main" java.lang.OutOfMemoryError: Java heap space

FindBugs:  at edu.umd.cs.findbugs.asm.FBClassReader.readLabel(FBClassReader.java:53)

FindBugs:  at org.objectweb.asm.ClassReader.accept(Unknown Source)

    :

- In the message list, the message of ERR500 is indicated

Please refer to the responsive actions to the error during the above-mentioned FindBugs execution.

- In the message list, the line number of indication of FindBugs is 0

In part of messages of FindBugs, it is likely that the line number information cannot be obtained from FindBugs. In this case, the line
number of applicable messages in Agile+ Relief J is displayed as 0.

- In editor, marker is not attached to the messages of FindBugs

If the line number of a message is not found in the file that is displayed in the editor, market will not be set in the editor. The same
situation occurs when the line number of a message is 0 (Refer to the previous content for details).

- When editor interaction is performed from the message list, the cursor locates the first line of the file in the editor

If the line number of a message is not found in the file that is displayed in the editor, the cursor locates the first line of the file in the editor.
The same situation occurs when the message line number is 0 (Refer to the previous content for details).
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Appendix B About cooperation with PMD
This appendix describes the PMD cooperation function of Agile+ Relief J and how to use the function.

B.1 What is PMD cooperation?
By PMD cooperation, the indication of PMD can be operated from Agile+ Relief J by cooperation with the PMD which is the static analysis
tool of open source.

PMD cooperation provides the following functions.

- PMD is automatically executed at the time of code check operation.

- The indication of PMD can be confirmed in the [Agile+ Relief Message List] view.

- Indication details of PMD can be confirmed in the [Agile+ Relief Message Detail] view.

By using PMD cooperation, code check can be enhanced and quality can be improved.

B.2 Using PMD
To use PMD, it is necessary to operate according to the following procedure.
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<Operations>

1. Install PMD

Download the distributed material from the public website (http://pmd.sourceforge.net/) of PMD. Please refer to ReadMe.txt under
the folder "Agile+ Relief installation folder \PGReliefJava" for the target version.

Unzip the distributed material that has been downloaded to any folder.

2. Prepare the "plugins.xml" file

Rename the model file of plugin file under the folder "Agile+ Relief installation folder\PGReliefJava" from "plugins.xml.tools" to
"plugins.xml".

When the existing plugin file is being renamed based on the setting of FindBugs cooperation this operation is unnecessary.

3. Edit the "plugins.xml" file

Here, edit according to the following procedure.

- Enable/Disable PMD cooperation

- Define the file path of PMD command

- Define PMD command options

The <plugin> tag after the following comment in the "plugins.xml" file is the definition of PMD cooperation.

Three kinds of <plugin> tag for the PMD cooperation is in each version of PMD. Please edit corresponding <plugin> tag to the version
of PMD used.

[For PMD 4.2.5-4.3]

[For PMD 5.0.0]

[For PMD 5.0.1-5.0.5]
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[For PMD 5.1.0-6.1.0]

Following is the detail of definition content.

Definition content
 

Definition item Tag Attribute Content of Configuration

Tool cooperation flag plugin enable Enable/Disable PMD cooperation.

PMD command option command executable Define the file path of PMD command.

PMD command option arg value Define PMD command options.

Tool cooperation flag

The PMD cooperation can be enabled or disabled by changing the tool cooperation flag. It can specify "true" of "false" to the value
of the "enable" attribute of the <plugin> tag.

[When PMD cooperation is enabled]

 
<plugin id="pmd" name="PMD" class=" ..... " enable="true">

[When PMD cooperation is disabled]

 
<plugin id="pmd" name="PMD" class=" ..... " enable="false">

PMD command

Specify an execution file (batch file) of PMD which is saved in installation folder of PMD.

 
<command executable="PMD installation folder\bin\pmd.bat">

PMD command option

Specify a PMD option to be passed to the execution file of PMD. The option specifies the combination of option name and the
parameter by <arg> tag. In case of no parameter, only specify the option name by <arg> tag.

Example) Specify the "-targetjdk 1.5" option (For PMD 4.2.5-4.3)

 
<arg value="-targetjdk"/>

<arg value="1.5"/>

The option is defined in plugins.xml file in advance. Please modify it if necessary. However, for the option that is the comment
such as <!-- unchangeable -->, please do not modify or delete it.
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Please confirm the option that specifies the Java version for parsing source. Please specify the same Java version as the
environment used.

Definition method of the Java version in each version of PMD is shown below. Please change the Java version shown in the
underlined part.

[For PMD 4.2.5-4.3]

 
<arg value="-targetjdk"/> <!-- Unchangeable -->

<arg value="1.5"/> <!-- Designation is required -->

[For PMD 5.0.0]

 
<arg value="-version"/> <!-- Unchangeable -->

<arg value="java"/> <!-- Unchangeable -->

<arg value="1.7"/> <!-- Designation is required -->

[For PMD 5.0.1-5.0.5]

 
<arg value="-version"/> <!-- Unchangeable -->

<arg value="1.7"/> <!-- Designation is required -->

[For PMD 5.1.0-6.1.0]

 
<arg value="-version"/> <!-- Unchangeable -->

<arg value="1.8"/> <!-- Designation is required -->

The trouble happens to the operation of PMD because the limit of the character length of command line of PMD is exceeded when
you specify a lot of reference class libraries.

Change a command option as follows when you specify a lot of reference class libraries.

[Old]
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<arg value="-auxclasspath" if="lib_path"/> <!-- Unchangeable -->
<arg value="{lib_path}" quote="true" if="lib_path"/> <!-- Unchangeable -->

[New]

 
<arg value="-auxclasspath" if="lib_path_file"/> <!-- Unchangeable -->
<arg value="file:///{lib_path_file}" quote="true" if="lib_path_file"/> <!-- Unchangeable -->

4. Edit of the rule set file

The check rule of PMD is defined by the following rule set files under the folder "Agile+ Relief installation folder\PGReliefJava".

[For PMD 4.2.5-4.3]

 
pmd_rulesets.xml Check rule of Java

pmd_rulesets_jsp.xml Check rule of JSP

[For PMD 5.0.0-5.0.5]

 
pmd5_rulesets.xml The following rule set is defined.

- Check rule of Java

- Check rule of JSP

- Check rule of XML

- Check rule of XSL

- Check rule of ECMAScript

[For PMD 5.1.0-6.1.0]

 
pmd5_1_rulesets.xml The following rule set is defined.

- Check rule of Java

- Check rule of JSP

- Check rule of XML

- Check rule of XSL

- Check rule of ECMAScript

- Check rule of PLSQL

- Check rule of Apache Velocity

In the rule set file that was mentioned above, the rule set offered by PMD project has already been defined. Please delete or add it if
necessary.

In addition, the description format of these rule set files follows the description format of the rule set of PMD. Please refer to the public
website (http://pmd.sourceforge.net/) of the PMD for details.

5. Execute PMD

Execute PMD by operating the code check of Agile+ Relief J.

In addition, the editing process of plugins.xml should be ended before using Agile+ Relief J. If the plugins.xml is edited in the process
of using Agile+ Relief J, please stop the usage of Agile+ Relief J through [Agile+ Relief J] - [Use Agile+ Relief J] menu, and set it to
usage state again.
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6. Confirm the result of PMD

The messages of PMD are mapped in the format of the messages of Agile+ Relief J and can be confirmed in [v Message List] view
and [Agile+ Relief Message Detail] view.

B.3 Mapping of PMD Messages
The messages of the PMD are converted into categories of Agile+ Relief J according to the mapping rule of the following categories, and
displayed in the [Agile+ Relief Message List] view.

Categories

In "plugins.xml.tools" that is the model file of plugin file, the relation between the PMD category and the Agile+ Relief J category is
defined as shown in the following tables. The PMD category that has not been described in the table is associated with "Other" of the
Agile+ Relief J category.

 
Table B.1 Mapping of PMD category and Agile+ Relief J category in "plugins.xml.tools"

Language PMD 4.2.5-4.3 PMD 5.0.0-5.0.5 PMD 5.1.0-6.1.0 Agile+ Relief J(Display
format in Message

List)

Java Android Rules Android Android Other

Java Basic Rules Basic Basic Maintainability/
Readability

Java Braces Rules Braces Braces Maintainability/
Readability

Java Clone Implementation
Rules

Clone Implementation Clone Implementation Reliability

Java Code Size Rules Code Size Code Size Maintainability/
Readability

Java Controversial Rules Controversial Controversial Reliability

Java Coupling Rules Coupling Coupling Maintainability/
Readability

Java Design Rules Design Design Maintainability/
Readability

Java Finalizer Rules Finalizer Finalizer Reliability

Java Import Statement
Rules

Import Statements Import Statements Maintainability/
Readability

Java J2EE Rules J2EE J2EE Portability

Java JavaBean Rules JavaBean JavaBean Other

Java JUnit Rules JUnit JUnit Other

Java Jakarta Commons
Logging Rules

Jakarta Commons
Logging

Jakarta Commons
Logging

Other

Java Java Logging Rules Java Logging Java Logging Reliability

Java Migration Rules Migration Migration Portability

Java Naming Rules Naming Naming Maintainability/
Readability
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Language PMD 4.2.5-4.3 PMD 5.0.0-5.0.5 PMD 5.1.0-6.1.0 Agile+ Relief J(Display
format in Message

List)

Java Optimization Rules Optimization Optimization Efficiency

Java Strict Exception Rules Strict Exception Strict Exception Reliability

Java String and
StringBuffer Rules

String and
StringBuffer

String and
StringBuffer

Efficiency

Java Security Code
Guidelines

Security Code
Guidelines

Security Code
Guidelines

Functionality

Java Type Resolution Rules Type Resolution Type Resolution Other

Java Unused Code Rules Unused Unused Maintainability/
Readability

Java - Comments Comments Maintainability/
Readability

Java - Empty Code Empty Code Maintainability/
Readability

Java - Unnecessary Unnecessary Maintainability/
Readability

JSP Basic JSF Rules Basic JSF Basic JSF Other

JSP Basic JSP Rules Basic JSP Basic JSP Other

ECMAScript - Basic Ecmascript Basic Ecmascript Other

ECMAScript - Braces Braces Maintainability/
Readability

ECMAScript - Unnecessary Unnecessary Maintainability/
Readability

ECMAScript - - Controversial
Ecmascript

Reliability

XML - Basic XML Basic XML Other

XSL - XPath in XSL XPath in XSL Other

PLSQL - - Tom Kyte's Despair Other

PLSQL - - Code Size Maintainability/
Readability

PLSQL - - PLSQL DATETIME Reliability

Apache
Velocity

- - Basic Velocity Other

This relation is defined with <option> tag in plugin file (plugins.xml) as follows in each category. The relation can be customized by
changing this definition.

 
<option id="category.PMD category name" value=" Agile+ Relief J category name"/>

Example) "Basic Rules" of PMD is associated with "Maintainability/Readability" of Agile+ Relief J.

 
<option id="category.Basic Rules" value="CATEGORY_MANITAINABILITY"/>

The category name of Agile+ Relief J must use the following.
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Table B.2 Agile+ Relief J category name
Agile+ Relief J category name Meaning

CATEGORY_MANITAINABILITY Maintainability/Readability

CATEGORY_RELIABILITY Reliability

CATEGORY_EFFICIENCY Efficiency

CATEGORY_FUNCTIONNALITY Functionality

CATEGORY_PORTABILITY Portability

CATEGORY_OTHER Other

Importance degree

The importance degree is defined as shown in the following tables. It is not possible to change.

 
Table B.3 Mapping of PMD importance degree and Agile+ Relief J importance degree

PMD Agile+ Relief J(Display format in Message List)

priority:1 Importance degree: S

priority:2 Importance degree: S

Other than the above Importance degree: W

B.4 Troubleshooting
This section describes the problems that frequently occur in PMD interaction and responsive actions.

- The following errors are displayed during code check

note) The underlined pass depends on the environment.

Please check if any following message is output to the Console view.

plugin: PMD

[Fatal Error] pmd.result:10:154: The entity "u65e5" was referenced, but not declared.

note) The underlined text depends on the environment.

This is the Java source to be analyzed, the Java identifier is most likely caused by the use of Multi byte character.

In PMD, when Multi byte character is used for the Java identifier, a normal analytical result might not be output.

In this case, the cooperation with the PMD cannot be used.
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- In [Agile+ Relief Message List] view, the following PMDERR is indicated

note) The underlined pass depends on the environment.

The following two are confirmed as a cause where the above-mentioned error occurs despite of a syntax mistake which is not found in
the property for analysis.

- Multi byte character is used for the Java identifier.

- The Java file is a file of the UTF-8 encode with BOM(Byte Order Mark).

In PMD, the analysis cannot be normally executed when the situation is such as the above-mentioned.

In this case, the cooperation with the PMD cannot be used.

- URL displayed in the [Agile+ Relief Message Detail] view is wrong.

In a specific PMD version, URL displayed in the [Agile+ Relief Message Detail] view is wrong. Wrong URL by a specific PMD version
is returned though information on URL is acquired from the execution result of PMD.

For this case, please refer from the homepage of PMD to a target document.
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